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TableStyles and CellStyles 1.1
Mastering the Art of Tables in Adobe InDesign

About Table and Cell Styles
A cell style is a collection of formatting attributes specific to cells that can be applied to a selected range of cells in a table. A 

table style is a collection of formatting attributes specific to tables that can be applied to a selected table. Cell and table styles 

can be used to set some formatting attributes while leaving other attributes unchanged.

Styles save time and make your work more efficient when you apply and revise table and cell formatting.  They give your tables 

a consistent look and allow you to share that consistent look across documents. When you change the formatting of a style, all 

cells or tables to which the style has been applied will be updated with the new format.

Using the Tables and Cell 
Styles palettes
Table styles and cell styles are found on separate palettes. 

However, the palettes are nearly identical in appearance. 

When you place an insertion point in a table or cell, the style 

that has been applied to that table or cell (if any) is highlighted 

in the Styles palette. If you select a range of cells covering 

multiple styles, no style is highlighted in the Styles palette.

To display the Table Styles palette:
n	 Choose Window > Table Styles.

To display the Cell Styles palette:
n	 Choose Window > Cell  Styles.

Thanks for using Teacup Software’s TableStyles and CellStyles! 

With table and cell styles, you can create a style and apply it 

to a table or a cell in a single click. Then, all you have to do is 

manage the styles, because any change you make to a style is 

automatically updated on all the tables the style is applied to. If 

you’ve worked with character or paragraph styles in InDesign, 

you’ll feel right at home with table and cell styles – they work 

in very similar ways.

Paragraph Styles palette A. Style name B. Style with 

additional formatting (overrides) C. New Style button D. 

Trash button E. Flyout menu

A

B

C D

E
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What’s new in 1.1 Pro
TableStyles and CellStyles 1.1 Pro have a number of noteworthy new features.

Preserve formatting when updating from a Linked Spreadsheet File

TableStyles and CellStyles 1.1 Pro enables table formatting to remain intact when InDesign content from a linked spreadsheet 

file is updated.  When changes are made to a linked file, cell and table styles are maintained in InDesign.  You do not have 

to repeatedly reformat a table when the spreadsheet is updated.  The following are the steps recommended to get the best 

results when linking and updating spreadsheet files.

1. 	 In InDesign’s Type preferences, make sure that the “Create Links When placing text and spreadsheet files” option is selected.

2. 	Choose File > Place to choose a spreadsheet file.  In the resulting , check the “Show Options” check box in the file 

chooser dialog.

3. 	 In the resulting options dialog, choose “Unformatted table” in the “Formatting” 

section of the dialog.  Though TableStyles and CellStyles Pro can handle 

relinking formatted tables, conflicts can arise if you add or remove rows to the 

spreadsheets.  When relinking unformatted tables, these conflicts do not exist.

4. 	Now with your spreadsheet linked into your InDesign table, you can apply table 

and cell styles to the table, or even apply local table or cell overrides, and all of 

those changes will be preserved when updating the spreadsheet link.

5. 	Be cautious, however, when applying local formatting to text in a table.  It is recommended that you associate 

paragraph styles with cell styles (see “Paragraph Styles in Cell Styles”, below) and depend on those paragraph styles 

to format your text.  When you update a linked table, the paragraph styles associated with a cell style will be re-

applied to the text in a cell, but local formatting applied to the text in the table will be lost.

 When updating a linked spreadsheet file a warning box will pop up telling you that you will lose your edits.  If you have 

modified the text of the table and not just the formatting, of the table and cells, then you will lose those edits to the table 

content, but but you won’t lose any formatting that you have applied to the table itself in InDesign.

 If desired, you can stop preserving InDesign formatting via the flyout menu in the TableStyles Pro or CellStyles Pro 

palette.  Just uncheck the menu item “Always Keep ID Formatting” and this feature will be disabled.

This feature is only available in the Pro version of TableStyles and CellStyles.

It is recommended that you link 

unformatted tables and do all of 

your table styling in InDesign

It is recommended that you link 

unformatted tables and do all of 

your table styling in InDesign
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Importing XML Files (Map Tags to Table/CellStyles)

Import XML files into InDesign tables with greater control, including 

linking to XML content for quick updating.  Apply the “Map Tags 

to Table/CellStyles” feature and tagged tables in InDesign can be 

automatically styled making it easy to import and export XML 

content from tables.

Once your XML has been imported and you have fully tagged 

content in your InDesign document, select the “Map Tags to Table/

Cell Styles” menu item from Table or CellStyles Pro palettes.  You 

can also access this menu item from the flyout menu in the XML 

pane in your document.

The resulting dialog works identically to the “Map Tags to Styles” dialog in InDesign.  For each tog in the document, choose 

the table or cell style that the tag maps to.  You can also use the “Map by Name” to automatically map the tags to the styles, 

if the names of both match.  When you click OK, the styles that you selected will be applied to any table or cell with the 

corresponding tag.  Thus you can easily style imported XML content in tables.

This feature is only available in the Pro version of TableStyles and CellStyles.

Tagging Styled Tables and Cells (Map Table/CellStyles to Tags)

Styled tables and cells are automatically tagged with the “Map 

Table/CellStyles to Tags” feature.  This makes exporting a full 

InDesign document to XML, including tables, easier than before.

Once your tables and cells have been fully styled with table 

and cell styles, select the “Map Table/Cell Styles to Tags” menu 

item from Table or CellStyles Pro palettes.  You can also access 

this menu item from the flyout menu in the XML pane in your 

document.

The resulting dialog works identically to the “Map Styles to Tags” 

dialog in InDesign.  For each table or cell style in the document, 

choose the tag you want to be applied.   You can also use the “Map by Name” to automatically map the styles to the tags, 

if the names of both match.  When you click OK, the tags that you selected will be applied to any table or cell that has the 

corresponding style.  Thus you can easily tag styled tables and cells in preparation for export to XML.

This feature is only available in the Pro version of TableStyles and CellStyles.

The “Map Tags to Table/Cell Styles” dialog, for easy 

styling of imported XML tables

The “Map Tags to Table/Cell Styles” dialog, for easy 

styling of imported XML tables

The “Map Table/Cell Styles to Tags” dialog, for easy 

tagging of styled tables and cells.

The “Map Table/Cell Styles to Tags” dialog, for easy 

tagging of styled tables and cells.



Simple, elegant solutions for Adobe InDesign

Page �

Paragraph Styles in cell styles

A paragraph style can be associated with a cell style.  When 

the cell style is applied, the associated paragraph style will be 

as well.  To associate a paragraph style with a cell style, follow 

these steps:

1.	 Bring up the dialog to edit the cell style.  This can 

most easily be done by double clicking on the cell 

style in the cell styles palette.

2.	 In the “Style Info” tab, right underneath the “Style Name” edit box, you’ll see a “Paragraph Style” dropdown.  That will 

list all the paragraph styles available in the document.  Choose your paragraph style and click OK.

Now when you apply that cell style, the paragraph style will be applied to all the text in the cell.  Using nested styles is a great 

way to style individual runs of text in the paragraph.

 If you don’t want a paragraph style applied along with a cell style, select “[No Associated Paragraph Style]” (this is the 

default).  Do not select “[No Paragraph Style]” unless you want that applied to the text in a cell.

This feature is only available in the Pro version of TableStyles and CellStyles.

What’s new in 1.1

InDesign CS-2 Support

TableStyles and CellStyles now work in Adobe InDesign CS-2 as well as CS.  A single license will work with both applications.

Snippet Support in CS-2

You can now create a snippet out of any text frame containing a styled table or cell, and the table style or cell style will also 

be exported.  When you import a snippet that has a styled table or cell, the table style or cell style gets imported into the 

document and applied to the appropriate table or cell.

INX Support

When you export an InDesign document to the INX format, table styles and cell styles are also exported to the INX format.  

This is very helpful for saving backwards from InDesign CS-2 to InDesign CS.

Table styles can override cell styles

When a table style and a cell style conflict, for example when both the table style and cell style are trying to define the same 

border, you can now make the table style override the cell style.  In previous versions, cell styles always overrode table styles.

Associate a paragraph style with a cell style through the 

Cell Style Options dialog (just double click a cell style)

Associate a paragraph style with a cell style through the 

Cell Style Options dialog (just double click a cell style)
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To make a table style override a cell style

1. Place the selection in an InDesign table

2. Hold down Ctrl-Option (Mac) or Ctrl-Alt (Win)

3. Click on the table style in the TableStyles palette

4. The table style will be re-applied to the table, but will override the cell style wherever any conflicts exist.

Enhanced scripting support

TableStyles and CellStyles now feature greatly enhanced scripting support.  In addition to all the scripting commands available 

in the previous version, in this version all attributes of any style can be directly accessed via the scripting interface.

Creating Styles
You can create a style that is based on the formatting of an existing table or cell, or you can select options in the table or cell 

style option dialog box.

If the styles you want already exist in another InDesign document, you can load those styles for use in your current document.

To define a new style:

1. If you want to base your new style on the formatting of an existing table or cell, select the table or cell or place the 

insertion point in the table or cell.

2. Do one of the following:
n	 Choose New Cell/Table Style in the Cell Styles or Table Styles palette menu.

n	 Click the Create New Style button in the Table Styles or Cell Styles palette.

3.	  For Style Name, select the tab at the top of the dialog type a name for your new style.

4. 	To specify the formatting attributes, click any of the tabs along the top of the dialog, such as “Fills” in the table styles 

dialog, for example, and specify the options you want to add to your style.

5. 	When you’ve finished specifying the formatting attributes, click OK.

Loading styles from another document      
You can load (import) table styles, cell styles, or both from another InDesign document into the active document. If you load 

a style from another document that has the same name as an existing style in the current document, you will have the option 

to either have the loaded styles overwrite the existing styles and apply its new attributes to all tables or cells in the current 

document that uses the old style, or you can have InDesign automatically rename the loaded styles so as to avoid any conflict.

To load styles from another InDesign document:

1. 	 In the Table or Cell Styles palette, choose Load All Styles in the flyout palette menu.
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2. 	Double-click the InDesign document containing the styles you want to import.

3.	 If there is a naming conflict, a dialog will appear allowing you to “Replace Style” or “Rename Style.”  Your choice will 

apply to all styles that have a conflict.

Applying Styles
By default, applying a table or cell style won’t remove any existing formatting applied to the table or cell, although you have the 

option of removing existing formatting when you apply a style. A plus sign (+) appears next to the current style in the Styles 

palette if the selected table or cell uses a table or cell style and also uses additional formatting that isn’t part of the applied 

style. (See Clearing overrides when applying table or cell styles.)

Note: After you apply a style to a table or cell, applying No Table Style or No Cell Style to the table or cell removes the style 

but leaves the formatting intact, unless you do this while holding down Alt (Windows) or Option (Mac OS). (See Removing 

style formatting from text.)

To apply a cell style to selected cells:

Click the cell style name in the Cell Styles palette. InDesign applies the cell style to the selected cells. 

To apply a table style to a selected table:

Click the table style name in the Table Styles palette.

Clearing overrides when applying table or cell styles
Formatting added to cells or tables that is not part of a style is called an override. When you apply a table or cell style, 

overrides remain intact. When you select a table or cell with an override, a plus sign (+) appears next to the style name.

You can clear cell styles and formatting overrides when you apply a style.

To apply a table or cell style and remove overrides:

In the Table or Cell Styles palette, hold down Alt (Windows) or Option (Mac OS) as you click the name of the style.

 When you clear table overrides, you only clear overrides that apply to the whole table, not to individual cells.  There is a 

way to remove all overrides on a table, including cell overrides and cell styles, when applying a table style.

To apply a table style and remove table overrides, cell overrides, and cell styles:

In the Table Styles palette, hold down Alt+Shift (Windows) or Option+Shift (Mac OS) as you click the name of the style.

Editing styles
You can change the definition of a table or cell style at any time. When you change the definition of a style, all of the tables or 



Simple, elegant solutions for Adobe InDesign

Page �

cells formatted with that style changes to match the new style definition.

To edit a style using the styles palette:

1. 	 In the Styles palette, double-click the style name, or select the style and choose Style Options in the Styles palette 

menu. Note that this applies the style to any selected table or cell frame.

2. 	Adjust settings in the dialog box, and then click OK.

To redefine the currently selected style based on a selected cell or table:

1. Select the table or cell formatted with the style you want to redefine.

2. Make changes to the table or cell attributes as necessary.

3. Choose Redefine Style in the Styles palette menu.

Deleting styles
You can delete table styles and cell styles from a document or from the application.  If the style that you are deleting has been 

applied to table or cells within a document, TableStyles and CellStyles will allow you to choose a new style to replace the style 

that you are deleting.

To delete a style:

1. Select the style name or names in the Styles palette.

2. Do one of the following:
n Choose Delete Styles in the palette menu.

n Click the Trash button at the bottom of the palette.

3.	 If the style you are deleting has been applied in the document, a dialog will pop up allowing you to choose a 

replacement style.  If you choose a replacement style, that style will be applied in place of the style being deleted, 

and all formatting from the replacement style will be applied to the table or cell.  If you choose not to have a 

replacement style, the formatting applied to the table will remain, but only as overrides, not as a style.

To delete all unused styles:

Choose Select All Unused in the Styles palette menu, and then click the Trash button.

Duplicating styles
You can duplicate an existing style.  All style information gets copied from the existing style to the duplicate style, but the 

duplicate style won’t be applied to any tables or cells.

To duplicate a style:

1. Select the style name or names in the Styles palette.
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2. Choose Duplicate Style in the palette menu.

Creating default table and cell styles
Like other styles in InDesign, you can create a set of default styles that are automatically copied to any new document that is 

created.  These default styles are saved in your preferences.

To create a default style

1.	 Close all documents.

2. 	With no documents open, create a table or cell style and edit it to your liking. This new style is now part of your 

defaults.

3.	 Create a new document.  The default table and cell styles are automatically copied onto the new document.

Removing style formatting from tables and cells
You can break the link between a table or cell and its assigned style. The table or cell’s formatting does not change, but any 

changes you make to the style will not be reflected in the table. You can also remove both the style and the formatting from 

tables or cells to which a style has been applied.

To break the link between a table or cell and its style:

1. Select the table or cell whose style you want to remove.

2. Do one of the following:
n 	 To remove the style but leave the formatting, click [No Table Style] or [No Cell Style] in the Styles palette.

n 	 To remove the style and any formatting overrides applied in addition to the style, hold down Alt (Windows) or 
Option (Mac OS), and then click [No Table Style] or [No Cell Style] in the Styles palette.

 You can also remove all formatting applied to a table, including cell styles and cell overrides, in one simple click

To remove all styling of any kind from a table

n	 Hold down Shift+Alt (Windows) or Shift+Option (Mac OS), and then click [No Table Style] in the Table Styles 
palette.
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AppleScript Guide
This guide is an overview of the methods available via the Applescripting dictionary.  The Applescript dictionary will also describe 

these events.  For a better idea of how to use these events in an actual script, please see the sample Applescript that came with 

the plug-in.  In addition to the events listed below, all attributes in an table style or cell style can be modified via a script.

TableStyles methods – Applescript

redefine table style None void Used to redefine a 
table style based on the 
selection

ApplyTableStyleToTables Name Type Description

to table or list 
of tables / 
Required

The tables to apply 
the style to

remove overrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a table 
style to the selected 
table

duplicate None table 
style

Used to copy a table 
style

ApplyTableStyle Name Type Description

remove overrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a table 
style to the selected 
table

import table styles Name Type Description

from alias or string / 
Required

The file to load styles 
from

void Used to load table 
styles from another 
document

delete Name Type Description

replacing with string / 
Optional

The table style to 
replace the style with

void Used to delete a table 
style

add Name Type Description

name string / 
Required

The table style name 

based on string / 
Optional

The table style to 
copy from

header rows integer / 
Optional

The number of 
header rows for the 
style

footer rows integer / 
Optional

The number of footer 
rows for the style

table 
style

Used to add a new 
table style
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CellStyles methods – Applescript

redefine cell style None void Used to redefine a 
cell style based on 
the selection

ApplyCellStyleToCells Name Type Description

to cell or list of 
cells / Required

The cells to apply the 
style to

remove overrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell 
style to the selected 
cell

duplicate None cell style Used to copy a cell 
style

ApplyCellStyle Name Type Description

remove overrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell 
style to the selected 
cell

import cell styles Name Type Description

from alias or string / Required The file to load styles 
from

void Used to load cell 
styles from another 
document

delete Name Type Description

replacing with string / Optional The cell style to 
replace the style with

void Used to delete a cell 
style

add Name Type Description

name string / Required The cell style name 

based on string / Optional The cell style to copy 
from

cell style Used to add a new 
cell style
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VisualBasic Scripting Guide
This is an overview of the methods available via VisualBasic or VBScript. For a better idea of how these methods work, please 

see the sample VBScript that comes with the plug-in.  In addition to the events listed below, all attributes in an table style or 

cell style can be modified via a script.

TableStyles methods – VisualBasic

RedefineTableStyle None void Used to redefine a 
table style based on 
the selection. Called 
on the document or 
application object.

ApplyTableStyleToTables Name Type Description

To table or array 
of tables / 
Required

The tables to apply the 
style to

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to keep 
them

void Used to apply a table 
style to the selected 
table. Called on the 
style object.

Duplicate None table 
style

Used to copy a table 
style. Called on the 
style object.

ApplyTableStyle Name Type Description

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a table 
style to the selected 
table. Called on the 
style object.

ImportTableStyles Name Type Description

From alias or 
string / 
Required

The file to load styles 
from

void Used to load table 
styles from another 
document. Called 
on the document or 
application object.

Delete Name Type Description

ReplacingWith string / 
Optional

The cell style to 
replace the style with

void Used to delete a table 
style.  Called on the 
style object you wish 
to delete.

Add Name Type Description

Name string / 
Required

The cell style name 

BasedOn string / 
Optional

The cell style to copy 
from

HeaderRrows integer / 
Optional

The number of 
header rows for the 
style

FooterRows integer / 
Optional

The number of footer 
rows for the style

table 
style

Used to add a new 
table style.  Called 
on the styles object 
on the application 
or document.  For 
example,  doc.
TableStyles.Add(...)
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CellStyles methods – VisualBasic

redefine cell style None void Used to redefine a 
cell style based on the 
selection.  Called on the 
document or application 
object.

ApplyCellStyleToCells Name Type Description

To cell or list 
of cells / 
Required

The cells to apply 
the style to

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell style 
to the selected cell.  Called 
on the style object.

Duplicate None cell style Used to copy a cell style.  
Called on the style object.

ApplyCellStyle Name Type Description

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell style 
to the selected cell. Called 
on the style object.

ImportCellStyles Name Type Description

From alias or 
string / 
Required

The file to load styles 
from

void Used to load cell styles 
from another document.  
Called on the document 
or application object.

Delete Name Type Description

ReplacingWith string / 
Optional

The cell style to 
replace the style with

void Used to delete a cell style. 
Called on the style object 
you wish to delete.

Add Name Type Description

Name string / 
Required

The table style name 

BasedOn string / 
Optional

The cell style to copy 
from

cell style Used to add a new cell 
style.  For eample, doc.
TableStyles.Add(...)
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JavaScript Scripting Guide
This is an overview of the methods available via JavaScript.  For a better idea of how to use these methods, please see the 

sample JavaScript that comes with the plug-in. In addition to the events listed below, all attributes in an table style or cell style 

can be modified via a script.

TableStyles methods – JavaScript

redefineTableStyle None void Used to redefine a 
table style based on 
the selection.  Called 
on the document or 
application object.

applytablestyletotables Name Type Description

To table or array 
of tables / 
Required

The tables to apply the 
style to

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to keep 
them

void Used to apply a table 
style to the selected 
table.  Called on the 
style object.

duplicate None table 
style

Used to copy a table 
style.  Called on the 
style object.

applyTableStyle Name Type Description

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a table 
style to the selected 
table. Called on the 
style object.

importTableStyles Name Type Description

From alias or 
string / 
Required

The file to load styles 
from

void Used to load table 
styles from another 
document.  Called 
on the document or 
application object.

remove Name Type Description

ReplacingWith string / 
Optional

The cell style to 
replace the style with

void Used to delete a table 
style. Called on the 
style object you wish 
to delete.

add Name Type Description

Name string / 
Required

The cell style name 

BasedOn string / 
Optional

The cell style to copy 
from

HeaderRrows integer / 
Optional

The number of header 
rows for the style

FooterRows integer / 
Optional

The number of footer 
rows for the style

table 
style

Used to add a new 
table style. Called 
on the styles object 
on the application 
or document.  For 
example,  app.
tableStyles.add(...)
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CellStyles methods – JavaScript

redefineCellStyle None void Used to redefine a 
cell style based on the 
selection.  Called on the 
document or application 
object.

applyCellStyleToCells Name Type Description

To cell or list 
of cells / 
Required

The cells to apply 
the style to

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell style 
to the selected cell.  Called 
on the style object.

duplicate None cell style Used to copy a cell style.  
Called on the style object.

applyCellStyle Name Type Description

RemoveOverrides boolean / 
Optional

True to remove 
overrides, false to 
keep them

void Used to apply a cell style 
to the selected cell. Called 
on the style object.

importCellStyles Name Type Description

From alias or 
string / 
Required

The file to load styles 
from

void Used to load cell styles 
from another document.  
Called on the document or 
application object.

remove Name Type Description

ReplacingWith string / 
Optional

The cell style to 
replace the style with

void Used to delete a cell style. 
Called on the style object 
you wish to delete.

add Name Type Description

Name string / 
Required

The cell style name 

BasedOn string / 
Optional

The cell style to copy 
from

cell style Used to add a new cell 
style. Called on the styles 
object on the application 
or document.  For 
example,  app.tableStyles.
add(...)
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